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CHAPTER-1 
INTRODUCTION 

1.1 General: 

What we have been exercising in our academic or professional carrier are 

based upon the western origin. Our careerists engineers, architects and 

planners are convinced of their research and investigations as a matter of 

disciplines, this is excellent, but we have a sacred duty to formulate a short 

of technology to fit into our merits. 

In keeping this in mind, we tried to develop a short formula to find out 

moment with the relation of height and shape variations of building. 

 

 

1.2 Importance of the study:  

The importance of the study for engineers are as follows: 

 Should consider both wind and earthquake effects for designing the 
building. 

 Should identify which floor govern maximum moment and design 
accordingly. 

 Should understand the risk associated with high rise building. 
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1.3 OBJECTIVES OF THE STUDY: 

To develop an empirical formula by which any engineer in home and 

abroad can easily find out relations between moment and height of various 

forms of the building. 

1.4 ORGANIZATION OF THE THESIS OR METHODOLOGY: 

For the study of this project we chose the following types and shapes of six 

to ten storied residential building. Load calculation is performed according 

to code UBC 94. We considered wind load and earthquake load based on 

3 zone in Bangladesh. 

Type & shape of building 

Type-1 Type-2 

Type=L-48XB-32 Type=L-64XB-48 

Type=L-64XB-32 Type=L-80XB-48 

Type=L-80XB-32 Type=L-96XB-48 

 
1.5 BACKGROUND: 

The history of high rise may be traced back to pyramids of Egypt about 48 

stories in height and the tower of Babel. 

People did not build tall structure again until the late 1600s, apart from a 

few roman apartment building of six or seven story tall. Tall building with 

iron skeletons began to be constructed in 1860s. In 1885 a ten story 

building was constructed in Chicago by William Le Baron Jenney. 
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CHAPTER-2 

SOFTWARE REVIEW 
 
2.1 What is ETABS (Extended 3D Analysis of Building: System)? 
 
The innovative and revolutionary new ETABS is the ultimate integrated software 
package for the structural analysis and design of buildings. Incorporating 40 years 
of continuous research and development, this latest ETABS offers unmatched 3D 
object based modeling and visualization tools, blazingly fast linear and nonlinear 
analytical power, sophisticated and comprehensive design capabilities for a wide-
range of materials, and insightful graphic displays, reports, and schematic 
drawings that allow users to quickly and easily decipher and understand analysis 
and design results.  

From the start of design conception through the production of schematic 
drawings, ETABS integrates every aspect of the engineering design process. 
Creation of models has never been easier - intuitive drawing commands allow for 
the rapid generation of floor and elevation framing. CAD drawings can be 
converted directly into ETABS models or used as templates onto which ETABS 
objects may be overlaid. The state-of-the-art SAPFIRE 64-bit solver allows 
extremely large and complex models to be rapidly analyzed, and supports 
nonlinear modeling techniques such as construction sequencing and time effects 
(e.g., creep and shrinkage).  

Design of steel and concrete frames (with automated optimization), composite 
beams, composite columns, steel joists, and concrete and masonry shear walls 
is included, as is the capacity check for steel connections and base plates. Models 
may be realistically rendered, and all results can be shown directly on the 
structure. Comprehensive and customizable reports are available for all analysis 
and design output, and schematic construction drawings of framing plans, 
schedules, details, and cross-sections may be generated for concrete and steel 
structures.  

ETABS provides an unequaled suite of tools for structural engineers designing 
buildings, whether they are working on one-story industrial structures or the tallest 
commercial high-rises. Immensely capable, yet easy-to-use, has been the 
hallmark of ETABS since its introduction decades ago, and this latest release 
continues that tradition by providing engineers with the technologically-advanced, 
yet intuitive, software they require to be their most productive.  
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2.2 Analysis Software: 

There is much finite element software for analyzing structure. ETABS is 

one of them. Every analysis is this thesis is done by using ETABS 16 

package. In the following paragraph we will discuss some of its features. 

2.3 History and advantage of ETABS: 

Dating back more than 40 years to the original development of TABS, the predecessor of 

ETABS, it was clearly recognized that buildings constituted a very special class of structures. 

Early releases of ETABS provided input, output and numerical solution techniques that took 

into consideration the characteristics unique to building type structures, providing a tool that 

offered significant savings in time and increased accuracy over general purpose programs. 

As computers and computer interfaces evolved, ETABS added computationally complex 

analytical options such as dynamic nonlinear behavior, and powerful CAD-like drawing tools in 

a graphical and object-based interface. Although ETABS 2016 looks radically different from its 

predecessors of 40 years ago, its mission remains the same: to provide the profession with the 

most efficient and comprehensive software for the analysis and design of buildings. To that end, 

the current release follows the same philosophical approach put forward by the original 

programs, namely: 

  

 Most buildings are of straightforward geometry with horizontal beams and vertical columns. 

Although any building configuration is possible with ETABS, in most cases, a simple grid 

system defined by horizontal floors and vertical column lines can establish building geometry 

with minimal effort. 

 Many of the floor levels in buildings are similar. This commonality can be used to dramatically 

reduce modeling and design time. 

 The input and output conventions used correspond to common building terminology. With 

ETABS, the models are defined logically floor-by-floor, column-by-column, bay-by-bay and 

wall- by-wall and not as a stream of non-descript nodes and elements as in general purpose 

programs. Thus the structural definition is simple, concise and meaningful. 

 In most buildings, the dimensions of the members are large in relation to the bay widths and 

story heights. Those dimensions have a significant effect on the stiffness of the frame. 

ETABS corrects for such effects in the formulation of the member stiffness, unlike most 

general-purpose programs that work on center- line-to-centerline dimensions. 

 The results produced by the programs should be in a form directly usable by the engineer. General purpose 

computer programs produce results in a general form that may need additional processing before they are 

usable in structural design. 
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2.4 An Integrated Approach: 

ETABS is a completely integrated system. Embedded beneath the simple, 

intuitive user interface are very powerful numerical methods, design 

procedures and international design codes, all working from a single 

comprehensive database. This integration means that you create only one 

model of the floor systems and the vertical and lateral framing systems to 

analyze, design, and detail the entire building. 

Everything you need is integrated into one versatile analysis and design 

package with one Windows-based graphical user interface. No external 

modules are required. The effects on one part of the structure from changes 

in another part are instantaneous and automatic. The integrated components 

include: 

Drafting for model generation 
 
Seismic and wind load generation 
 
Gravity load distribution for the distribution of vertical loads to columns and 
beams when plate bending floor elements are not provided as a part of the 
floor system 
Finite element-based linear static and dynamic analysis 
 
Finite element-based nonlinear static and dynamic analysis (available in 
ETABS Nonlinear & Ultimate versions only) 
Output display and report generation 
 
 Steel frame design (column, beam and brace) 
 Concrete frame design (column and beam) 
 Concrete slab design 
 Composite beam design 
 Composite column design 
 Steel joist design 
 Shear wall design 
 Steel connection design including column base plates 
 Detail schematic drawing generation 

 



Page 6 of 57 

 

2.5 Modeling Features: 

The ETABS building is idealized as an assemblage of shell, frame, link, tendon, 

and joint objects. Those objects are used to represent wall, floor, column, beam, 

brace, tendon, and link/spring physical members. The basic frame geometry is 

defined with reference to a simple three- dimensional grid system. With relatively 

simple modeling techniques, very complex framing situations may be considered. 

The buildings may be unsymmetrical and non-rectangular in plan. Torsional 

behavior of the floors and inter story compatibility of the floors are accurately 

reflected in the results. The solution enforces complete three- dimensional 

displacement compatibility, making it possible to capture tubular effects 

associated with the behavior of tall structures having relatively closely spaced 

columns. 

 

Semi-rigid floor diaphragms may be modeled to capture the effects of in- plane 

floor deformations. Floor objects may span between adjacent levels to create 

sloped floors (ramps), which can be useful for modeling parking garage structures. 

Modeling of partial diaphragms, such as in mezzanines, setbacks, atriums and 

floor openings, is possible without the use of artificial (“dummy”) floors and column 

lines. It is also possible to model situations with multiple independent diaphragms 

at each level, allowing the modeling of buildings consisting of several towers rising 

from a common base. 

 

The column, beam and brace elements may be non-prismatic, and they may have 

partial fixity at their end connections. They also may have uniform, partial uniform 

and trapezoidal load patterns, and they may have temperature loads. The effects 

of the finite dimensions of the beams and columns on the stiffness of a frame 

system are included using end offsets that can be automatically calculated. 

The floors and walls can be modeled as membrane elements within plane stiffness 

only or full shell-type elements, which combine both in- plane and out-of-plane 

stiffness. Floor and wall members may have uniform and non-uniform load 

patterns in-plane or out-of-plane, and they may have temperature loads. The 

column, beam, brace, floor and wall members are all compatible with one another. 
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2.6 Analysis Features: 
 
Static analyses for user specified vertical and lateral floor or story loads are 

possible. If floors with out-of-plane bending capability are modeled, vertical loads 

on the floor are transferred to the beams and columns through bending of the floor 

elements. Otherwise, vertical loads on the floor are automatically converted to 

span loads on adjoining beams, or point loads on adjacent columns, thereby 

automating the tedious task of transferring floor tributary loads to the floor beams 

without the need to explicitly model the secondary framing. 

 

The program can automatically generate lateral wind and seismic load patterns to 

meet the requirements of various building codes. Three- dimensional mode 

shapes and frequencies, modal participation factors, direction factors and 

participating mass percentages are evaluated using eigenvector or Ritz vector 

analysis. P-Delta effects may be included with static or dynamic analysis. 

Response spectrum analysis, linear time history analysis, nonlinear time history 

analysis, and static nonlinear (pushover) analysis are all possible. The static 

nonlinear capabilities also allow you to perform incremental construction analysis 

so that forces that arise as a result of the construction sequence are included. 

 

Results from the various static load cases may be combined with each other or 

with the results from the dynamic response spectrum or time history analyses. 

Output may be viewed graphically, displayed in tabular output, compiled in a 

report, exported to a database file, or saved in an ASCII file. Types of output 

include reactions and member forces, mode shapes and participation factors, 

static and dynamic story displacements and story shears, inter-story drifts and 

joint displacements, time history traces, and more. 

Import and export of data may occur between third-party applications such as 

Revit and AutoCAD from Autodesk, or with other programs that support the CIS/2 

or IFC data models. 

 

ETABS uses the SAPFire™ analysis engine, the state-of-the-art equation solver 

that powers all of CSI's software. This proprietary solver exploits the latest in 

numerical technology to provide incredibly rapid solution times and virtually 

limitless model capacity. 
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2.7 Design Features: 
 

Design of steel frames, concrete frames, concrete slabs, concrete shear 

walls, composite beams, composite columns, and steel joists can be per- 

formed based on a variety of US and International design codes. Flexural, 

shear and deflection checks may all be performed depending upon the 

material and member type. Steel and concrete frame members may be 

optimized from auto select lists, and concrete sections are designed using 

reinforcing bar sizes chosen from US or International standards. Concrete 

slab design may be done using either design strips, or be based on the finite 

element method, and may include the effects of post-tensioning. Steel 

connection design automates the review of beam-beam and beam-column 

connections based on user specified bolt and shear plate preferences. Steel 

base plate design verifies the size, thickness, and anchorage of the 

connection. 

 

2.8 Detailing Features: 
 

Schematic construction drawings showing floor framing, column schedules, 

beam elevations and sections, steel connection schedules, and concrete 

shear wall reinforcing may be produced. Concrete reinforcement of beams, 

columns, and walls may be selected based on user-defined rules. Any 

number of drawings may be created, containing general notes, plan views, 

sections, elevations, tables, and schedules. Drawings may be printed directly 

from ETABS or exported to DXF or DWG files for fur- the refinement. 
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CHAPTER-3 
STRUCTURAL MODELING AND ANALYSIS 

 

3.1 Introduction: 

To present the procedure of analysis and design of the RCC structures is 

consider a standard grid of 16’x16’ and taken different shape from six to ten 

stored residential building. Dead load, Live load, Vertical load, Lateral load, 

Wind load, Seismic load are taken on the basis of contemporary trend 

performing by designers. 

Given: 

Material Properties: 
 
Concrete Compressive strength, f’c = 4 ksi 
Yield Strength of Rebar, fy = 72.5ksi (500Mpa) 
Yield Strength of Shear Rebar, fy=40 ksi 
 

Load: 

Live Load= 40 psf  

Partition Wall=35 psf 

Floor Finish=25 psf 
 

 

Beam and Column size: 

 

Column=20”x20” 

Beam=12”x20” 

Beam=12”x21”                                                         

All Slab 6” Thickness  
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3.1.1 Methodology flow Diagram: 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

  

 

 

 

Start ETABS 

Define Material 

Define Frame Sections 

Define Slab Sections 

Load Patterns 

Load Combinations 

Drawing Beams, Column, Slab 
 

Uniform Load Assign 

Diaphragms 

Mashing and Define Mass Source 

Check Model 

Automatic Rectangular Mesh 

Run Analysis and Design Check 
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3.1.2 Plan:

 

 

 

 

 



Page 12 of 57 

 

  

Step Action 
 

3.1.3 
 
Start ETABS 2016: 
Menu Command: File>New Model. 
 

 Click on  radio button 
Set Concrete Design Code to ACI 318-08 

 
Click  

 New Model Quick Templates window appears 
From New Model Quick Templetes window 

Click on radio button 

Click on  button   
 

 Grid System Data window appears 

Click on  radio button 

Click  button to add an extra grid (Grid E) in X  
Set the X Grid Data  and Y Grid Data as follows 

X Grid Data  Y Grid Data 

Grid ID X Spacing (ft)  Grid ID Y Spacing (ft) 

A 16’  1 16’ 

B 16’  2 16’ 

C 16’  3 16’ 

D 16’  4 0 

E 0    
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Click  
Brings back to New Model Quick Templates window 
 
SetSimple Story Data as below 
Number of Stories 11  

Typical Story Height 10 ft 

Bottom Story Height 7 ft 

Click  then Click  
ETABS Main Window appears 
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3.2.1 
 
 

Define Material Properties of 4 ksi Concrete: 
Menu Command: Define>Material Properties… 
Define Materials Window appears 

Click  
Add New Property Window appears 
Select from the dropdown list

 
 

Click  
Material Property Data Window appears 
Set Material Property Data window as follows 
Material Name Conc4000psi  

Weight per Unit Volume 150 lb/ft3 
Modulus of Elasticity, E 57000*4000^.5 lb/in2 

Poisson’s Ratio, U 0.2  
Coefficient of Thermal Expansion, A 5.5E-6 1/F 

 

Click  
Material Property Design Data Window appears 

Set  

Click  
Returns to Material Property Data Window 

Click  
Returns to Define Materials Windowwith a new matrial in the list 

3.2.2 Define Material Properties of 72.5ksi Reinforcement (Rebar): 
From the Define Materials Window 

Click  
Add New Property Window appears 
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Select from the dropdown list

 

 

Click  
Material Property Data Window appears 
Set Material Property Data window as follows 

Material Name Rebar72500psi  

Weight per Unit Volume 490 lb/ft3 

Modulus of Elasticity, E 29E6 lb/in2 

Coefficient of Thermal Expansion, A 6.5E-6 1/F 

 

Click  
Material Property Design Data Window appears 
SetDesign Properties for Rebar Materialsas follows 

Minimum Yield Strength, Fy 72500 lb/in2 

Minimum Tensile Strength, Fu 83375 lb/in2 

Expected Yield Strength, Fye 1.1*72500 lb/in2 

Expected Tensile Strength, Fue 1.1*83375 lb/in2 

Click  
Returns to Material Property Data Window 

Click  
Returns to Define Materials Windowwith a new matrial in the list 
 

3.2.3 Define Material Properties of 40ksi Reinforcement (Rebar): 
Follow the same procedure as above.. 
From theDefine Materials Window 

Click  
Add New Property Window appears 
Select from the dropdown list
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Click  
Material Property Data Window appears 
Set Material Property Data window as follows 

Material Name Rebar40000psi  

Weight per Unit Volume 490 lb/ft3 

Modulus of Elasticity, E 29E6 lb/in2 

Coefficient of Thermal Expansion, A 6.5E-6 1/F 

 
Click  
Material Property Design Data Window appears 
SetDesign Properties for Rebar Materialsas follows 
 

Minimum Yield Strength, Fy 40000 lb/in2 

Minimum Tensile Strength, Fu 60000 lb/in2 

Expected Yield Strength, Fye 1.1*40000 lb/in2 

Expected Tensile Strength, Fue 1.1*60000 lb/in2 

Click  
Returns to Material Property Data Window 

Click  
Returns to Define Materials Windowwith a new matrial in the list 
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Click  
Returns to Main Window 
 

3.3.1 Define Frame Sections: Column 20”x20” with 8 Rebars: 
Menu Command: Define>Section Properties>Frame Sections… 

Click  
Delete Multiple Frame Section Properties Window appears 
Select all the Frame Sections (Click the first item holding SHIFT key and Click the last 
item or simply click, hold and drag) 

Click  
Again Select all Frame Sections (Click the first item holding SHIFT key and Click the last 
item or simply click, hold and drag) 

Click  
Atleast one frame section must be present. Hence a massege box appears.  

Click  
Returns to Delete Multiple Frame Section Properties Window 

Click  
Retuns to Frame Properties Window 

Click  
Frame Property Shape Type Window appears 

Click Concrete Rectangular button 
Frame Section Property Data Window appears 
Set General Data and Section Dimensions as follows 

Property Name Col20”x20” 

Material Conc4000psi 

Depth 20 in 

Width 20 in 
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Click  
Frame Section Property Reinforcement Data Window appear 
Set the window as follows 

 
Longitudinal Bars 
Clear Cover for Confinement Bars 1.5 in 

Number of Longitudinal Bars Along 3-dir Face 4  

Number of Longitudinal Bars Along 2-dir Face 4  

 
Confinement Bars 

 
Longitudinal Spacing of Confinement Bars 6 in 

Number of Confinement Bars in 3-dir 2  

Number of Confinement Bars in 2-dir 2  

 

Click  
Retuns to Frame Section Property Data Window 

Click  
Retuns to Frame Properties Windowwith a new item 

Select W10x12 and Click  

Click  
 

3.3.2 Define Frame Sections:Beam 12”x20” 
From Frame Properties Window 

Click  
Frame Property Shape Type Window appears 
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Click Concrete Rectangular button 
Frame Section Property Data Window appears 
Set General Data and Section Dimensions as follows 
Property Name Beam12”x20” 

Material Conc4000psi 

Depth 20 in 

Width 12 in 

Click  
Frame Section Property Reinforcement Data Window appear 

Click radio button 
SetRebar Material as below 

 
Set Cover to Longitudianl Rebar Group Centroid as below 

Top Bars 2.5 in 

Bottom Bars 2.5 in 

 

Click  
Retuns to Frame Section Property Data Window 

Click  
Retuns to Frame Properties Window with a new item 
 

3.3.3 Define Frame Sections: Beam 12”x21”  
From Frame Properties Window 
Select Beam12x20 

Click  
Frame Section Property Data Window appears 
Set General Data and Section Dimensions as follows 

Property Name Beam12x21 

Material Conc4000psi 

Depth 21 in 

Width 12 in 
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Click  
Retuns to Frame Properties Windowwith a new item 
At last I make this Column and Beam 

 
Click  

Returns to main window 
 

3.3.4 Define Slab Sections: 6” thick floor and roof slab: 
Menu Command: Define>Section Properties>Slab Sections… 
Slab Properties Window appears 

Click  
Slab Property Data Window appears 
Set General Data and Property Data as follows 

Property Name Slab6” 

Material Conc4000psi 

Type Slab  

Thickness 6 in 
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Click  
Returns to Slab Properties Window 

 
Click  
Returns to ETABS main Window 
 

3.4.1 Define: Load Patterns (Dead, Live, FF, PW) 
Menu Command: Define>Load Patterns… 
Define Load Patterns Window appears 
Set 

 

Click  
Adds FF(Superimposed Dead Load) Load Pattern 
Again Set 

 

Click  
Adds PW(Superimposed Dead Load) Load Pattern 

 

Click  
Returns to ETABS main Window 
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3.5.1 
 
 
 
 

 
Drawing all Beams: 
Menu Command: Draw>Draw Beam/Column/Brace Objects> Draw Beam/Column/Brace  (Plan/Elev,3D) 
Properties of Object window appear on left bottom 
Set Property as follows from the drop-down list 

Property 

 

 
3.4.2 Define: Load Combinations: 

Menu Command: Define>Load Combinations… 
Load Combination Window appears 

Click  
Add Default Design Combinations Window appears 

Click  

 

Click  
 
Returns to Load Combinations Window with 2 combinations 

 

Click  
Returns to ETABS main Window 
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3.5.2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 

Set Plan Drawing Mode to Similar stories: 
Select One  Stories from the drop-down list at bottom right corner 

 
 
To Draw Beam: 
Menu Command: Draw>Draw Line Object>Create Line in Region or at Clicks. 
 
Set "Properties of Object" Beam 12”x20” and draw the beams like plan. 
Draw Column : 
Draw Section: Set "All Stories" First.  
Menu Command: Drow> Draw line object in Region or at click 
Set "Properties of Object"  

 And draw the Column. 
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3.5.3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Draw Floor Slab: 
Draw Section: Set "Similar Stories"  
Menu Command: DrawDraw area ObjectDraw Areas  

Set "Properties of Object" Slab 6” 
Then draw the slab. 
 

 
 
 
Now all slab are drawn: 

 
 
From the plan view go to the base and select all points: At first Select 
everything Base 
Menu Command AssignJoint/Points Restraints 
Select "Fixed Support" then click Apply-Ok 
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3.6.1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Uniform Load Assign: 
Menu Command: SelectBy wall/slab/deck sections>select slab 6” then click 
ok. 
 All floor slab has been selected.  
 
Now,  Menu Command: AssignShell/area loadsUniform 

Set, Load Case Name-Live Load 40 Then click Ok. 

 
Click on previous selection. 
 
Menu Command: AssignShell/area loadsUniform 
Set, Load Case Name-FF Load 25 Then click Ok. 
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Click on previous selection 
Menu Command: AssignShell/area loadsUniform 
Set, Load Case Name-PW Load 35 Then click Ok. 

 
Now all slab load has been assigned. 
 
Now Select Frame property:  
Menu Command: Select SelectPropertiesFrame Sections and Select 
Beam 



Page 27 of 57 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.6.2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Distributed Frame Loads Assign: 
Menu Command: AssignFrame LoadsDistributed  
Now Load Patten = Select PW And Uniform Load=0.5 Kip/ft and Then click  

 
Now click  Apply  then Ok 
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3.6.3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Define Static Load Case: 
Then Menu Command : Define> load Patterns: 
To set wind load For X Axis: Load-WLX, Type-Wind, Self weight multiplier-0, 
Auto lateral load-UBC94 Now click Add New Load. 
 
To set wind load For Y Axis : Load-WLY, Type-Wind, Self weight multiplier-0, 
Auto lateral load-UBC94 Now click Add New Load 
 
To set Earthquake load For X Axis: Load-EQX, Type-Seismic, Self weight 
multiplier-0, Auto lateral load-UBC94 Now click Add New Load 
 
To set Earthquake load For Y Axis: Load-EQY, Type-Seismic, Self weight 
multiplier-0, Auto lateral load-UBC94 Now click Add New Load 
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For WLX Click modify lateral load options 

Windward Coefficient ,Cq or Cp=1.28 

Leeward Coefficient, Cq=0.0001 

Wind Speed (mph)=130 

Exposure Type=B 

Importance Factor=1 

Parapet Height=3.5 ft 

 
Now Click Modify/Show--For X Axis Direction Angles, 0 Degree 

 
Click Ok and again Click Ok 
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For WLY Click modify lateral load options: 

Windward Coefficient ,Cq or Cp=1.56 

Leeward Coefficient, Cq=0.0001 

Wind Speed (mph)=130 

Exposure Type=B 

Importance Factor=1 

Parapet Height=3.5 ft 

 
Now Click Modify/Show-For Y Axis Direction Angles, 90 Degree 

 
Click ok and again Click ok 

For EQX Click modify lateral load options 
Direction and EccentricityOnly select X Dir 

Select   
And ct=0.03 

Per code=0.15 

Site Coefficient, S=1.5 

Importance Factor,I=1 

Numerical Coefficient,Rw=8 

Story Range :  
Top Story= Roof 
Bottom Story= Base 
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Click ok 
 

For EQY Click modify lateral load options 

Direction and EccentricityOnly select Y Dir 

Select   
And ct=0.03 

Per code=0.15 

Site Coefficient, S=1.5 

Importance Factor,I=1 

Numerical Coefficient,Rw=8 

Story Range :  
Top Story= Roof 
Bottom Story= Base 

 
Click ok         
Returns to main window 
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3.7.1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Then Menu Command : Define  Mass source 

 
 

Mashing and Define Mass Source: 
Now Click Modify/Show Mass Source 
Mass Source Select only Specified Load patterns 

Mass Multiplies For load patterns 
Dead x1 Click Add, Live x 0.25 Click Add, PW x1 Click Add ,FFx1 Click Add 

 
Click ok 
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3.7.2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Diaphragms: 
 
Then Menu Command : All Slab Select Assign Shell Diaphragms Click 
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3.7.3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Design Stripe: 
 
Then Menu Command : EditAdd/Edit Design Strips Add Design Strips 
Now , Click include Middle Strips 
Grid Direction=X 
Strip Layer=A 
Click Apply Then Ok 

 
 
Then Menu Command : EditAdd/Edit Design Strips Add Design Strips 
Now , Click include Middle Strips 
Grid Direction=Y 
Strip Layer=B 
Click Apply then Ok 
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3.7.4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

At Last The Diaphragms === 

 
Check Model: 
Then Menu Command: Analyze->Check Model->Select All And Click ok 

 
No warning messages were generated. 
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3.7.5 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.8.1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Automatic Rectangular Mesh Setting For Floors: 
 
Menu Command: AnalyzeAutomatic Rectangular Mesh Setting For Floors  
Then   
Approximate Mesh Size =2 ft Click ok 

 
 

Run Analysis: 
Then Menu Command: Analyze--> Run Analysis  
After Analysis:nalysis: 
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3.8.2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Design Check: 
 
Datiels of Analysis: Menu Command :DesignConcrete Frame DesignStart 
Design Check: 
For Details: 
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 Chapter-04 
Load On Building 

 
4.1 WIND LOAD CALCULATION USING BNBC 1993: 
Table 1: Exposure Category as per BNBC 1993 and UBC 1991 and afterward 
 

BNBC 1993 UBC 1991 and afterward 

Exposure A: Urban and sub-urban areas, industrial areas, 

wooded areas, hilly or other terrain covering at least 20 

per cent of the area with obstructions of 6 meters  or more 

in height and extending from the site at least 500 meters 

or 10 times the height of the structure, whichever is 

greater. 

Exposure B: It has terrain with buildings, forest or 

surface irregularities 

20 feet (6 meter) or more in height covering at least 20 

percent of the ground level area extending 1 mile (1.61 

km) or more from the site. 

Exposure B: Open terrain with scattered obstructions 

having heights generally less than 10m extending 800 m 

or more from the site in any full quadrant. This category 

includes air fields, open park lands, sparsely built-up 

outskirts of towns, flat open country and grasslands. 

Exposure C: It has terrain that is flat and generally 

open, extending ½ mile (0.81 km) or more from the 

site in any full quadrant. 

Exposure C: Flat and unobstructed open terrain, coastal 

areas and riversides facing large bodies of water, over 1.5 

km or more in width. Exposure C extends inland from the 

shoreline 400 m or 10 times the height of structure, 

whichever is greater. 

Exposure D: It represents the most severe exposure in 

areas with basic  wind speeds of 80 miles per hour 

(mph) (129 km/h) or greater and has terrain that is flat 

and unobstructed facing large bodies of water over 1 

mile (1.61 km) or more in width relative to any 

quadrant of the building site. Exposure D extends 

inland from the shoreline ¼ mile (0.40 km) or 10 times 

the building height, whichever is greater. 

Note: Exposure A, B and C in BNBC is similar to Exposure B, C and D in UBC respectively 

 
Table 2: Design Wind Pressure as per BNBC and UBC 

BNBC 1993 UBC 1991 and afterward 

 

where 

      

             
 

 
  

 

velocity-to-pressure conversion 

coefficient 

= 47.2x10
-6 

when velocity in km/h and 

pressure is in kN/m
2

 

= 0.00256 when velocity in mph and 

pressure is in lb/ft
2

 

            
where 

      combined height, exposure and gust 

factor coefficient 

      pressure coefficient for the structure 

or portion of structure under 

consideration as given in 

      wind stagnation pressure at 

the standard height of 33 feet 
=                     when velocity in mph 

  

and      is in lb/ft
2

 

      basic wind speed 

      structure importance coefficient as 

given in 

Table 3 
      combined height and exposure 

coefficient as given in Table 4 

      basic wind speed obtained from Table 

5 or Figure 1 or site specified value. 
                           

 
 

  

where 

      gust coefficient as given in Table 4 

      pressure coefficient to be used for 

determination of wind loads on 

buildings and structures as set forth 

in sec Error! Reference source not 

found. 

    Importance factor. Structure 

importance is categorized in four 

categories and importance factors vary 

from 1.00 to 1.15. Low risk structure 

category is not included. Later wind 

importance factor is defined as and 

miscellaneous structure category 

included. 
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Table 3 Structure Importance Categories and Coefficients CI  (BNBC 1993: Table 
6.1.1 and Table 6.2.9) 
 
 

Structure 

Importance 

Category 

Occupancy Type or Functions of Structure Structure 

Importance 

Coefficients, CI 

I) Essential 

Facilities 

Hospital and other medical facilities having surgery and 

emergency treatment area. 
1.25 

  Fire and police stations. 
  Tanks or other structures containing, housing or supporting water 

or other fire-suppression materials or equipment required for the 

protection of essential or hazardous facilities, or special 

occupancy structures. 
  Emergency vehicle shelters and garages. 
  Structures and equipment in emergency-preparedness centers, 

including cyclone and flood shelters. 
  Standby power-generating equipment for essential facilities. 
  Structures and equipment in government  communication centers 

and other facilities required for emergency response. 

II) Hazardous 

Facilities 

Structures housing, supporting or containing  sufficient 

quantities of toxic or explosive substances to be dangerous to the 

safety of the general public if released. 

1.25 

III) Special 

Occupancy 

Structures 

Covered structures whose primary occupancy is  public assembly 

with capacity > 300 persons. 

1.00 

 Buildings for schools through secondary or day-care centers with 

capacity > 250 students. 

  patients not included above.  

  Jails and detention facilities.  

  All structures with occupancy > 5,000 persons.  

  

Structures  and  equipment  in  power-generating  stations  

and  

  other public utility facilities not included above, and required  

  for continued operation.  

IV) Standard 

All structures having occupancies or functions not listed 

above. 1.00 

 Occupancy   

 Structures   

V) Low Risk Buildings and Structures that exhibit a low risk to human life 0.80 

 Structures and  property  in  the  event  of  failure,   such  as  agricultural  

  buildings,   minor   storage   facilities,   temporary   facilities,  

  construction facilities, and boundary walls.  
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Table 4: Combined Height and Exposure Coefficient, Cz and Gust Coefficient, CG 

 

150 492 1.736 2.171  2.404 1.111 1.057  1.005 1.929 2.295 2.416 
 

              

160 524.8 1.787 2.212  2.436 1.104 1.053  1.003 1.973 2.329 2.443 
 

             
 

170 557.6 1.835 2.25  2.465 1.098 1.049  1.001 2.015 2.360 2.467 
 

             
 

180 590.4 1.883 2.287  2.494 1.092 1.046  1.000 2.056 2.392 2.494 
 

              

190 623.2 1.928 2.323  2.521 1.087 1.043  1.000 2.096 2.423 2.521 
 

             
 

200 656 1.973 2.357  2.547 1.082 1.04  1.000 2.135 2.451 2.547 
 

             
 

220 721.6 2.058 2.422  2.596 1.073 1.035  1.000 2.208 2.507 2.596 
 

              

240 787.2 2.139 2.483  2.641 1.065 1.03  1.000 2.278 2.557 2.641 
 

             
 

260 852.8 2.217 2.541  2.684 1.058 1.026  1.000 2.346 2.607 2.684 
 

             
 

280 918.4 2.91 2.595  2.724 1.051 1.022  1.000 3.058 2.652 2.724 
 

              

300 984 2.362 2.647  2.762 1.045 1.018  1.000 2.468 2.695 2.762 
 

               
 

(1)Linear interpolation is acceptable for intermediate values of z. 

(2) Combined coefficient which is the same as Ce in UBC 1991 and afterward 

 

Height Height 

Coefficient, Cz 
(1) 

for Coefficient, CG 
(1) 

for 

Combined Coefficient 
 

above above   
(1)(2)

 for exposure 
 

ground ground exposure category exposure category  category  
 

            
 

level, z level, z 
A B 

  
C A B 

  
C A B C  

(m) (ft) 
    

 

             
 

0 0 0.368 0.801  1.196 1.654 1.321  1.154 0.609 1.058 1.380 
 

              

4.5 14.76 0.368 0.801  1.196 1.654 1.321  1.154 0.609 1.058 1.380 
 

             
 

6 19.68 0.415 0.866  1.263 1.592 1.294  1.140 0.661 1.121 1.440 
 

             
 

9 29.52 0.497 0.972  1.37 1.511 1.258  1.121 0.751 1.223 1.536 
 

              

12 39.36 0.565 1.055  1.451 1.457 1.233  1.107 0.823 1.301 1.606 
 

             
 

15 49.2 0.624 1.125  1.517 1.418 1.215  1.097 0.885 1.367 1.664 
 

             
 

18 59.04 0.677 1.185  1.573 1.388 1.201  1.089 0.940 1.423 1.713 
 

              

21 68.88 0.725 1.238  1.623 1.363 1.189  1.082 0.988 1.472 1.756 
 

             
 

24 78.72 0.769 1.286  1.667 1.342 1.178  1.077 1.032 1.515 1.795 
 

             
 

27 88.56 0.81 1.33  1.706 1.324 1.17  1.072 1.072 1.556 1.829 
 

              

30 98.4 0.849 1.371  1.743 1.309 1.162  1.067 1.111 1.593 1.860 
 

              

35 114.8 0.909 1.433  1.797 1.287 1.151  1.061 1.170 1.649 1.907 
 

             
 

40 131.2 0.965 1.488  1.846 1.268 1.141  1.055 1.224 1.698 1.948 
 

              

45 147.6 1.017 1.539  1.89 1.252 1.133  1.051 1.273 1.744 1.986 
 

              

50 164 1.065 1.586  1.93 1.238 1.126  1.046 1.318 1.786 2.019 
 

             
 

60 196.8 1.155 1.671  2.002 1.215 1.114  1.039 1.403 1.861 2.080 
 

              

70 229.6 1.237 1.746  2.065 1.196 1.103  1.033 1.479 1.926 2.133 
 

              

80 262.4 1.313 1.814  2.12 1.18 1.095  1.028 1.549 1.986 2.179 
 

             
 

90 295.2 1.383 1.876  2.171 1.166 1.087  1.024 1.613 2.039 2.223 
 

              

100 328 1.45 1.934  2.217 1.154 1.081  1.020 1.673 2.091 2.261 
 

              

110 360.8 1.513 1.987  2.26 1.114 1.075  1.016 1.685 2.136 2.296 
 

             
 

120 393.6 1.572 2.037  2.299 1.134 1.07  1.013 1.783 2.180 2.329 
 

             
 

130 426.4 1.629 2.084  2.337 1.126 1.065  1.010 1.834 2.219 2.360 
 

              

140 459.2 1.684 2.129  2.371 1.118 1.061  1.008 1.883 2.259 2.390 
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Table 5: Basic Wind Speeds for Selected Locations in Bangladesh (BNBC 1993: 

Table 6.2.8) 

 Basic Basic  Basic Basic 
 

Location 
Wind Wind 

Location 
Wind Wind 

 

Speed Speed Speed Speed  

  
 

 (km/h) (mph)  (km/h) (mph) 
 

Angarpota 150 93 Lalmonirhat 204 127 
 

       

Bagerhat 252 157 Madaripur 220 137 
 

       

Bandarban 200 124 Magura 208 129 
 

      
 

Barguna 260 162 Manikganj 185 115 
 

      
 

Barisal 256 159 Meherpur 185 115 
 

       

Bhola 225 140 Maheshkhali 260 162 
 

      
 

Bogra 198 123 Moulvibazar 168 104 
 

      
 

Brahmanbaria 180 112 Munshiganj 184 114 
 

       

Chandpur 160 99 Mymensingh 217 135 
 

      
 

Chapai Nawabganj 130 81 Naogaon 175 109 
 

      
 

Chittagong 260 162 Narail 222 138 
 

       

Chuadanga 198 123 Narayanganj 195 121 
 

      
 

Comilla 196 122 Narsinghdi 190 118 
 

       

Cox’s Bazar 260 162 Natore 198 123 
 

       

Dahagram 150 93 Netrokona 210 130 
 

      
 

Dhaka 210 130 Nilphamari 140 87 
 

       

Dinajpur 130 81 Noakhali 184 114 
 

      
 

Faridpur 202 126 Pabna 202 126 
 

      
 

Feni 205 127 Panchagarh 130 81 
 

       

Gaibandha 210 130 Patuakhali 260 162 
 

      
 

Gazipur 215 134 Pirojpur 260 162 
 

      
 

Gopalganj 242 150 Rajbari 188 117 
 

      
 

Habiganj 172 107 Rajshahi 155 96 
 

      
 

Hatiya 260 162 Rangamati 180 112 
 

       

Ishurdi 225 140 Rangpur 209 130 
 

      
 

Joypurhat 180 112 Satkhira 183 114 
 

       

Jamalpur 180 112 Shariatpur 198 123 
 

      
 

Jessore 205 127 Sherpur 200 124 
 

       

Jhalakati 260 162 Sirajganj 160 99 
 

      
 

Jhenaidah 208 129 Srimangal 160 99 
 

       

Khagrachhari 180 112 St. Martin’s Island 260 162 
 

      
 

Khulna 238 148 Sunamganj 195 121 
 

       

Kutubdia 260 162 Sylhet 195 121 
 

       

Kishoreganj 207 129 Sandwip 260 162 
 

       

Kurigram 210 130 Tangail 160 99 
 

      
 

Kushtia 215 134 Teknaf 260 162 
 

       

Lakshmipur 162 101 Thakurgaon 130 81 
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Table 6: Overall Pressure Coefficients, Cp(2) for Rectangular Buildings with Flat 
 

Roofs (BNBC 1993: Table 6.2.15(1)) 

 

 
Interpolation for Cp Value: 

 

 
      

 
  
 

  
 
 

  

  

WLX         

INPUT               

L 64 ft           

B 48 ft           

h 111 ft           

Output               

L/B 1.33             

h/B 2.31             

Cpy               

Manual Interpolation 
Table For Check               

h/B 
L/B         

0.65 1.33 1         

0.5 1.55 1.25714286 1.4         

2.31   1.28712406           

10 2 1.41428571 1.7         
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WLY 

INPUT       

L 48 ft   

B 64 ft   

h 111 ft   

Output       

L/B 0.75     

h/B 1.73     

Cpy       

Manual Interpolation 
Table For Check       

h/B 
L/B 

0.65 0.75 1 

0.5 1.55 1.50714286 1.4 

1.73   1.56004464   

10 2 1.91428571 1.7 
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4.2  EARTHQUAKE LOAD CANCULATION: 
 

 
 

 
SEISMIC WEIGHT 
 
Seismic weight, W, is the total dead load of a building or a structure, including partition walls, and applicable portions of 

other imposed loads listed below: 

a) For live load up to and including 3 kN/m2, a minimum of 25% of the live load shall be applicable. 
 

b) For live load above 3 kN/m2, a minimum of 50% of the live load shall be applicable. 
 

c) Total weight (100%) of permanent heavy equipment or retained liquid or any imposed load 
 

sustained in nature shall be included. 
 
Where the probable imposed loads (mass) at the time of earthquake are more correctly assessed, the designer may go for 
higher percentage of live load. 
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Table 6.2.24 

   Response Modification Coefficient for Structural Systems,   
 

          
 

  Basic Structural    Description of Lateral Force Resisting System  
R (2) 

 

  

System
(1)

 
        

 

  
 

        
 

 a. Bearing Wall  1. Light framed walls with shear panels     
 

  System 
 

 i) 
Plywood walls for structures, 3 storeys or 
less   8  

 

     ii) All other light framed walls   6  
 

    2. Shear walls      
 

     i) Concrete    6  
 

     ii) Masonry    6  
 

    3.Light steel framed bearing walls with tension only bracing  4  
 

   
 

4. 
Braced frames where bracing carries gravity 
loads     

 

     i) Steel    6  
 

     ii) Concrete (3)   4  
 

        

4 
 

 

     iii) Heavy timber    
 

         
 

 b. Building Frame  1. Steel eccentric braced frame (EBF)   10 
 

  System  2. Light framed walls with shear panels     
 

   

 

 i) 
Plywood walls for structures 3-storeys or 
less   9  

 

     ii) All other light framed walls   7  
 

    3. Shear walls      
 

     i) Concrete    8  
 

     ii) Masonry    8  
 

    4. Concentric braced frames (CBF)     
 

     i) Steel    8  
 

     ii) Concrete (3)   8  
 

        

8 
 

 

     iii) Heavy timber    
 

         
 

 c. Moment Resisting  1. Special moment resisting frames (SMRF)     
 

  Frame System   i) Steel    12 
 

     ii) Concrete    12 
 

    
2. 

Intermediate moment resisting frames (IMRF), 
concrete 

(4)  8  
 

   

 

    
 

    3. Ordinary moment resisting frames (OMRF)   
6 

 
 

     i) Steel     
 

        

5 
 

 

     

ii) Concrete 
(5)

 
   

 

   
 

     
 

 d.  Dual System  1. Shear walls    

12 
 

     i) Concrete with steel or concrete SMRF   
 

     ii) Concrete with steel OMRF   6  
 

     iii) Concrete with concrete IMRF (4)   9  
 

     iv) Masonry with steel or concrete  SMRF   8  
 

     v) Masonry with steel OMRF   6  
 

     vi) Masonry with concrete IMRF 
(3)

   7  
 

    2. Steel EBF    
12 

 

     i) With steel SMRF   
 

       

6 
 

 

     ii) With steel OMRF    
 

         
 

    3. Concentric braced frame (CBF)   
10 

 

     i) Steel with steel SMRF   
 

       

6 
 

 

     ii) Steel with steel OMRF    
 

       

9 
 

 

     

iii) Concrete with concrete SMRF 
(3)

 
   

 

   
 

   
6  

 

     

iv) Concrete with concrete IMRF 
(3)

 
   

 

   
 

     
 

 e.  Special Structural   See Sec 1.3.2, 1.3.3, 1.3.5     
 

  Systems          
 

Notes: 
(1) Basic Structural Systems are defined in Sec 1.3.2, Chapter 1. 
(2) See Sec 2.5.6.6 for combination of structural systems, and Sec 1.3.5 for system limitations. 
(3) Prohibited in Seismic Zone 3. 
(4) Prohibited in Seismic Zone 3 except as permitted in Sec 2.5.9.3. 
(5) Prohibited in Seismic Zones 2 and 3. Sec 1.7.2.6. 
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CHAPTER-05 

RESULT AND DISCUSSIONS 
 
5.1 Data analysis: 
 
 
 
 
5.1.1 Finding Maximum Moment Value: 
 
After checking deferent floor from analysis we found maximum moment on beam at: 

 
From above procedure we collect / found max moment with respect to grid type & level 
which is put on the graph as bellow: 
 

 

5.1.2  Grid Type: 

 

Type-1 Type-2 

Type=L-48XB-32 Type=L-64XB-48 

Type=L-64XB-32 Type=L-80XB-48 

Type=L-80XB-32 Type=L-96XB-48 
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5.1.3 Graphs: 
Graph is prepared with the relation of moment. 
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5.1.4 Three Seismic Zone of Bangladesh: 
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Remarks: 
 
We chose 3 Locations Dhaka, Khulna and Sylhet of 3 separate Zones to assign  
lateral loads (both wind and seismic loads) to perform analysis of our project. 
But it is mentionable that for different Zones, Moment variations also different. 
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5.2 Result: 
 
Y=mx+C ---------------------------------(1) 
nY=nmx+nc------------------------------(2)  [Multiply By n]            
∑Y=m∑x+nC---------------------------(3)  
∑xY=m∑x2+C∑x----------------------(4)  [Multiply By x] 
 

x(Height) ft x2(Height) ft2 Y(Moment) kip-ft xY (kip-ft2) 

71 5041 123.9093 8797.5603 

81 6561 145.4292 11779.7652 

91 8281 168.2449 15310.2859 

101 10201 192.4438 19436.8238 

111 12321 216.4696 24028.1256 

∑x=455 ∑ x2=42405 ∑Y=846.4968 ∑xY=79352.5608 

 
Now, Putting the value in 3 & 4 No. Equation: 
846.4968=m*455+5*C                             [Where n=5] 
79352.5608=m*42405+C*455 
 
So, m=2.3214                 [By Using Calculator] 
      C=-41.944      
 
Y=mx+C 
Y=2.3214*101+(-41.944)            [when, x=101 ft] 
  =192.5174  kip-ft    (Equation Proved) 
 
 
 

Moment Variation Follows a Straight Line. 
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6.1 Conclusions: 
 
 Through this analysis it has been found that lateral loads (Wind, 

Earthquake) have considerable effect to grate extent in the design of a 
high rise building frame. 

 For analysis the selected building frame we have used ETABS 
software. Which is the most common and accurate analysis procedure 
now a days. 

 We found maximum moment on beam at 2nd and 3rd floor (Maximum 
Cases). 

 
 
 
 
6.2 FURTHER STUDIES: 
 
From the above study the following recommendation can made for further 
study: 
 The analysis can be performed by varying the number of story, height 

and number of spans of the building.  
 The analysis involves finite element techniques with relatively coarse 

mesh. So accuracy of the result can be improved through using fine 

mesh. 

 This study can be compared between other approximate methods.                                                          
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